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What is Workshare Professional

Workshare Professional reimagines multi-party review and collaboration and ensures the 
safe and accurate exchange of information, enabling the collaborative evolution of high 
value business documents. 

Workshare Professional is a desktop application that automates managing changes to 
business documents, protects against unauthorized content disclosure and delivers the 
world’s most secure PDF creation, all in one integrated solution.

Key features of Workshare Professional include:

 Comparison of Word, PowerPoint, Excel and PDF files, including image-based 
PDF files

 Comparison of selected pieces of content, such as a single paragraph or clause

 Ability to accept/reject in a comparison and then create new documents

 Advanced comparison features including one-to-many comparisons (Word and 
PDF files), version comparisons, and access from within Office and Document 
Management Systems

 Access to comparison functionality from within Outlook as well as right-click access 
from within individual emails

 Conversion from PDF to DOC format for local files and from within the DMS/CRM

 Advanced, interactive metadata cleaning/PDF creation/secure file transfer for 
attachments in Outlook

 Comprehensive content risk protection enabling the discovery and removal of 
hidden sensitive data as well as visible sensitive data

 Options to save and share Office documents to Workshare online

 Access and visibility into online collaborative workspaces directly from Office

 Secure file sharing from all devices and browsers with metadata removal and end-
to-end encryption

 Centralized policy design and enforcement administrator tools

 ECM/DMS and OCR integration with desktop comparison features

 Centralized user account management and control

 Complete access to Workshare online functionality to share and collaborate on 
documents, including setting folder access and permissions, positional commenting 
and reviewer communications with presence indicators

 Desktop sync app to synchronize your online content to your local desktop
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Note: Workshare Professional can be installed without Microsoft Office integration. In this 
case, the comparison functionality is only available from the Workshare comparison
applications and the metadata removal functionality is only available when sending 
emails.

What’s New in Workshare Professional 10.2

The Professional 10.2 release includes the following:

Added Save As PDF functionality into Compare for 
PowerPoint

This brings Compare for PowerPoint in line with our other comparison products. Users can 
save a comparison as a PDF file or a WCPF (Workshare Compare for PowerPoint) file in 
the DMS or CRM, locally or on their network.

Kofax Power PDF 

Workshare Professional 10.2 supports Power PDF and users can compare and clean PDF 
files created in Power PDF.

Note: Power PDF is a PDF editing tool.

Latest DMS support

This release includes support for OpenText eDOCS DM 16.5.
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Export comparison in Compare for Excel

The exported comparison is much easier to read and bug fixes have made the export 
process much smoother. 

There’s also a handy checkbox so the comparison immediately opens once the export is 
complete. 

Workshare Configuration Manager

The following parameters were added:

 Compare for PowerPoint – Default report layout (Comparison > Administration)

Determines the default report layout when saving a PowerPoint comparison as a 
PDF. Also, when creating a comparison report after comparing presentations, this 
determines the default report layout selected. Options are: Full comparison report
(default), Change summary only or Slide view only.

 Compare for PowerPoint – Include unchanged slides (Comparison > 
Administration)

If this option is selected, all slides are included when saving a PowerPoint 
comparison as a PDF. Also, when creating a comparison report after comparing 
presentations, the Include unchanged slides checkbox will be selected by default.

 Compare for PowerPoint – Default save format (Integrations > General)

Determines the default format for the comparison when saving a comparison or 
creating a comparison report in Workshare Compare for PowerPoint. Options are: 
WCFP (default) or PDF.
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System Requirements

The recommended system requirements for Workshare Professional 10.2 are:

 Intel Core i3 @ 2.5GHz

 AMD Athlon 64 X4

 4GB RAM

Workshare Professional 10.2 has a 32-bit version for 32-bit Microsoft Office environments 
and a 64-bit version for 64-bit Office environments.

Certified Environments for Workshare Professional 10.2
(32-bit version)

Workshare Professional 10.2 (32-bit version) has been tested and certified in a number of 
environments. If your environment is not included in the following list, it may still be a 
compatible environment. Contact Workshare Customer Support 
(support@workshare.com) for any help.

For details of which environments previous versions of Workshare Professional/Compare/
Protect were certified against, refer to previous versions of release notes on the 
knowledge base.

Note: Unless otherwise stated, all environments are the English version with the en-us 
language set.

Operating System:

 Microsoft Windows 10 (32 bit and 64 bit)

 Microsoft Windows 8.1 (32 bit and 64 bit) + Japanese

 Microsoft Windows 7 SP1 (32 bit and 64 bit) + Chinese Simplified & French

Citrix:

 With Microsoft Windows Server 2012 R2 or 2016 (64 bit)

 Citrix XenApp 7.5 

 Citrix XenDesktop 7.5

Note: Check with your Citrix vendor about which Windows operating system supports 
your version of Citrix. 

Microsoft Office System:

 Microsoft Office 365 (desktop)

 Microsoft Office 2019 (32 bit) – including click-to-run

mailto:support@workshare.com
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 Microsoft Office 2016 (32 bit) – including click-to-run

 Microsoft Office 2013 SP1 (32 bit) + Japanese – including click-to-run

Email System:

 Microsoft Outlook 365 (desktop)

 Microsoft Outlook 2019 (32 bit)

 Microsoft Outlook 2016 (32 bit)

 Microsoft Outlook 2013 SP1 (32 bit) + Japanese

 IBM Notes 9.0.1 FP7, FP8 and FP9

Note: Interactive Protect and the replace email attachment with link features of 
Workshare are not supported in a Notes environment.

Browsers:

 Microsoft Edge, latest version

 Microsoft Internet Explorer 11

 Google Chrome, latest version

 Mozilla Firefox, latest version

Microsoft SharePoint:

 Microsoft SharePoint 2013 SP1

DMS Integration:

Note: Check with your DMS vendor about which Windows operating system supports 
your DMS. 

 NetDocuments

ndOffice must be installed to use the Workshare NetDocuments integration.

Note: If you want Workshare to be available when using the NetDocuments Send 
to application functionality, Microsoft Internet Explorer must be installed 
(although it does not have to be the default browser).

 iManage clients:

 FileSite/DeskSite 9.0 Update 6 and above

 Work 10 Desktop for Windows 10.0 and above

 Work 10 web client (You will need to install Workshare iManage Integration 
Server in order to launch comparisons from the iManage browser interface.)

http://workshare.force.com/knowledgebase/articles/Text_Article/Installing-Workshare-iManage-Integration-Server
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Note: If you use a Work 10.2 server, it must include iManage Work Web Server 
10.2.0.91 (which can be requested from iManage with reference CSAR-2673).

 OpenText: 

 eDOCS DM 16.5

 eDOCS DM 10

 eDOCS DM 5.3.1 COM only (Patch 6)

 Worldox:

 GX4

Workshare will endeavor to support future service packs of certified environments.

Certified Environments for Workshare Professional 10.2
(64-bit version)

Workshare Professional 10.2 (64-bit version) has been tested and certified in a number of 
environments. If your environment is not included in the following list, it may still be a 
compatible environment. Contact Workshare Customer Support 
(support@workshare.com) for any help.

For details of which environments previous versions of Workshare Professional/
Compare/Protect were certified against, refer to previous versions of release notes on the 
knowledge base.

Note: Unless otherwise stated, all environments are the English version with the en-us 
language set.

Operating System:

 Microsoft Windows 10 (64 bit)

Citrix:

 With Microsoft Windows Server 2012 R2 (64 bit)

 Citrix XenApp 7.5 

 Citrix XenDesktop 7.5

Note: Check with your Citrix vendor about which Windows operating system supports 
your version of Citrix. 

Microsoft Office System:

 Microsoft Office 365 (desktop) (64 bit)

 Microsoft Office 2019 (64 bit)

 Microsoft Office 2016 (64 bit)

mailto:support@workshare.com
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 Microsoft Office 2013 SP1 (64 bit)

Email System:

 Microsoft Outlook 365 (desktop) (64 bit)

 Microsoft Outlook 2019 (64 bit)

 Microsoft Outlook 2016 (64 bit)

 Microsoft Outlook 2013 SP1 (64 bit)

Browsers:

 Microsoft Edge, latest version

 Microsoft Internet Explorer 11

 Google Chrome, latest version

 Mozilla Firefox, latest version

DMS Integration:

Note: Check with your DMS vendor about which Windows operating system supports 
your DMS. 

 NetDocuments

ndOffice must be installed to use the Workshare NetDocuments integration.

Note: If you want Workshare to be available when using the NetDocuments Send 
to application functionality, Microsoft Internet Explorer must be installed 
(although it does not have to be the default browser).

 iManage clients:

 FileSite/DeskSite 9.3 (64 bit) and above

 Work 10 Desktop for Windows 10.0 (64 bit) and above

 Work 10 web client (You will need to install Workshare iManage Integration 
Server in order to launch comparisons from the iManage browser interface.)

Note: If you use a Work 10.2 server, it must include iManage Work Web Server 
10.2.0.91 (which can be requested from iManage with reference CSAR-2673).

 OpenText: 

 eDOCS DM 16.5

 eDOCS DM 10

Workshare will endeavor to support future service packs of certified environments.

http://workshare.force.com/knowledgebase/articles/Text_Article/Installing-Workshare-iManage-Integration-Server
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Important Information

Secure PDFs – Workshare Professional is unable to compare secure PDFs or convert 
secure PDFs to Word format. Secure PDFs are PDF files with security settings configured.

POP/IMAP – Workshare Professional does not support Outlook when it is configured with 
a POP or IMAP account.

Important installation information

 Workshare Professional installs program files to a sub-folder within the Workshare 
folder named Modules.

 Install: A user is unable to install Workshare Professional if Microsoft Windows 
Installer 3.1 is not installed. This can be downloaded from the following location 
https://www.microsoft.com/en-us/download/details.aspx?id=25.

 Windows 7: When UAC is set to Default, running the Workshare Professional 
install displays the UAC prompt. You must approve the prompt and Workshare 
Professional will be installed. Running the Workshare Professional MSI silently will 
fail when UAC is set to Default because the user is not given the opportunity to 
approve the UAC prompt. Therefore for silent installs, disable UAC.

If you have installed any Alpha or Beta builds of Workshare Professional, we strongly 
recommend that you first uninstall them before installing Workshare Professional 10.

Change Requests Fixed

The following are fixed customer change requests that have been validated for this release 
- for more information, please contact Customer Support.

Ref CR Description

PRO-3481 - Some images are shown with a black border in Compare

PRO-3475 - Compare for Excel - Exported file has the wrong 
background colour

PRO-3407 CR01168003 Email security dialog box appears a second time after 
selecting ndMail filing location

PRO-3393 Some deletions are incorrectly formatted when comparing 
specific documents

PRO-3389 Title logo and grey background missing in saved PDF after 
comparing specific documents

PRO-3382 Deleted cells in tables have yellow borders when 
comparing and saving certain Word documents

https://www.microsoft.com/en-us/download/details.aspx?id=25
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Ref CR Description

PRO-3381 Image is shown as inserted though it has moved when 
comparing certain documents

PRO-3372 Certain shapes are stretched in Compare view when 
comparing Word documents

PRO-3327 Incorrect behavior is observed upon performing 'Convert to 
PDF' action on password protected files when FIPS option 
is enabled.

PRO-3325 Incorrect behavior is observed upon performing 'Combine 
files in Workshare' action on  password protected files 
when FIPS option is enabled.

PRO-3324 Incorrect behavior is observed upon comparing password 
protected files in Workshare Compare when FIPS option is 
enabled.

PRO-3321 Incorrect behavior is observed upon clicking on the 
password protected files in 'Clean files' section and 'Apply' 
button in IP pane when FIPS option is enabled.

PRO-3318 Workshare compare crashes when comparing the data 
from Selective Compare for the second instance of 
Compare

PRO-3253 The comparison couldn't be performed error dialog is 
displayed when comparing Excel files which contain a 
empty text box.

PRO-3239 iManage test connection fails in WCM (Admin Mode) in 
some circumstances

PRO-3238 Error message "Document profile is invalid" when save 
comparison document using iManage Work 10

PRO-3145 Compare for PPT is not launching when FIPS Algorithm is 
enabled in GPO. 

PRO-3120 Selective compare and Workshare batch clean are not 
responding when FIPS Algorithm is enabled in GPO. 

PRO-3112 Text in overlaid objects is not always rendered in the 
correct font or size in Compare for Excel

PRO-3110 Certain documents with rotated objects cannot be 
compared in Compare for Excel

PRO-3090 CR01166398 Document header containing textbox is slightly cutoff in 
Compare view and when saving comparison as PDF

PRO-3089 CR01166298 "The comparison couldn't be performed" error occurs when 
comparing specific Excel Spreadsheets
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Ref CR Description

PRO-3062 CR01165945 Compare for Excel - Unexpected results when exporting 
Excel comparison using 'Indirect highlights' option

PRO-3029 CR01165948 Upgrading from 9.5.x to 10.x does not honour File Share & 
Sync module state

PRO-2995 Microsoft Excel is not displayed under supported addin's 
section on the install dialog.

PRO-2954 Comparison is not brought into focus, when user performs 
a new comparison from “Workshare Compare” shortcut 
icon after minimizing currently open comparison

PRO-2908 Workshare Compare' shortcut is created while performing 
Upgrades from Protect Standalone(10.0 Rev 2) to Protect 
Standalone(10.1) upgrade in MSI QR mode

PRO-2862 CR01164585 iManage box being displayed behind Workshare desktop 
app

PRO-2801 Export option check boxes do not result in the correct 
output in the exported file

PRO-2784 'Compare' button is not enabled when files are selected 
through drag and drop action in Workshare Compare for 
PowerPoint

PRO-2772 CR01164105 This app is preventing shutdown' message appears when 
shutting down machine with Compare for PowerPoint 
window open

PRO-2770 CR01164174 When Workshare Ribbon Add-In for Microsoft Office 
Outlook and Outlook Option "Show add-in user interface 
errors" are enabled, opening an email produces an error

PRO-2769 CR01163844 Compare Crashes with exception "0xc0000374" when 
comparing certain documents with comments, tables and 
two languages 

PRO-2656 CR01163711 Embedded objects are not cleaned in documents when 
lightspeed clean option is enabled

PRO-2557 CR01162870 Compare crashes when closing from the Taskbar on a 
machine with two monitors

PRO-2462 CR01162638 Documents attached from Solcase disappearing when 
compressing through Interactive Protect

PRO-2460 CR01162561 Compare crashes when printing redline to any PDF printer 
in specific environment

PRO-2365 CR01162340 Comparing certain PDF documents crashes Compare or 
produce overlapping tables in redline
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Ref CR Description

PRO-1835 Continues progress bar is displayed while sending the 
email with attachments through Desktop profiles if Outlook 
is in closed state.

PRO-1805 Sound annotation metadata inserted through comment 
option is not removed from the PDF when 'Exclude markup 
- Movie and Sound annotations(PDF)' option is disabled

PRO-1510 CR01149191 Multi paragraph footnote causing numbering list display 
incorrectly in Compare view

PRO-1146 CR01137713 Headers and footers are missing when comparing specific 
original Word document against scanned PDF version

PRO-918 CR01130757 Chinese comments are not displayed in TER view

PRO-870 CR01073920 Compare via Workshare (for Excel) is grayed out in 
DeskSite

PRO-829 CR01066935 Converting redline to pdf results is missing several pages

PRO-782 CR01129790 OpenText save dialog box appears in the background 
when saving redline to OpenText

PRO-690 CR01125849 Error: 80040154 Class not registered (Exception from 
HRESULT: 0x80040154(REGDB_E_CLASSNOTREG)) 
when sending documents to Compare from NetDocuments 
on Citrix

PRO-195 CR01040402 Printer not activated error code -30' error when creating 
PDF reports with Protect disabled

PRO-164 CR01069080 Draft email attachments being processed when reporting 
separate email as junk

Known Issues

The following are known issues in the Workshare Professional 10.2 release - for more 
information, please contact Customer Support.

Ref Description

PRO-3754 Compare for Excel is not launching when FIPS Algorithm is enabled in GPO.

PRO-3753

01170892

Unable to select certain cells after running Excel comparison.

PRO-3733 The error “Opentext eDocs DM: Object has been deleted” message may be 
displayed when a comparison is performed from using Selective Compare.
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Ref Description

PRO-3708

01170207

Bullets may not show correctly when comparing .doc files in fast mode.

PRO-3698 After closing Compare for PowerPoint, the application process may still be 
running and visible in Task Manager.

PRO-3449

01168494

The error "System.Threading.ThreadAbortException" may be displayed 
when saving a redline as attach/relate to original/modified document in 
OpenText DM 16.5.

PRO-3409

01168025

iManage integration: After an upgrade, the recent files list in Compare’s 
Document Selection dialog retains the recent files compared prior to the 
upgrade. However, you are not able to compare those recent iManage files 
because the path is shown as “interwovenSite://…” rather than 
“iManage://…”.

PRO-3405

01167611

iManage Work 10: The redline may not be saved as a version of the original 
or modified document but instead it is saved as a new document.

PRO-3137

01166593

When cleaning metadata from a PowerPoint attachment with the lightspeed 
clean option enabled, the slide animation sequence may be removed.

PRO-3034

01165736

When comparing a Word document saved in .doc format and using Number 
List formatting, the comparison may not show the numbering correctly.

PRO-2609

01163333
Links in Excel documents are detected again even after removal.

PRO-2513
Errors can occur when using Selective Compare if Compare dialogs are 
open and the "Launch new comparison in running instance" configuration 
option is enabled.

PRO-2342

01161036

Replies to comments in Word are detached when the lightspeed clean 
option is enabled.

PRO-1387
Compare for Excel: Changes may not be indicated correctly when 
comparing spreadsheets with a deleted/inserted column when the first row is 
empty.

PRO-1386
Compare for Excel: Merged cells are displayed as individual cells when the 
merged cell is not in full view on the comparison window.

PRO-1019
Compare for Excel: Focus is not completely applied to the last change in the 
comparison window if the user clicks the Last Change button for the first 
time.

PRO-837

01061816

After running a comparison in Workshare Compare, the right aligned text in 
the footer may move to become center-aligned.
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Ref Description

PRO-815

01062255

Combine PDF is not picking up changes made to an open iManage 
document even after saving it. The workaround is to close the saved 
document and reopen it before using the Combine PDF functionality.

PRO-792

01088791

After running a comparison in Workshare Compare, some line numbering 
and table text and row cells maybe be missing.

PRO-528
IBM Notes 9.0.1 FP7 only. Attachments are duplicated in sent items when 
the email is processed through desktop profiles or all mail profiles. This is an 
issue with IBM Notes.

PRO-527
IBM Notes only. Attachments are not automatically compressed to a zip file
when the limit specified in the WCM is reached.

PRO-525
The positioning of signature components in RTF format emails can be 
incorrect after processing with Protect.

PRO-109

01099537

The error ‘Failed to compare documents. Unable to convert documents.’ is 
displayed when comparing specific scanned PDF documents.

PRO-22
The Reset Layout option is missing from the Quick Access Toolbar 
drop-down in Compare for PowerPoint.

01012100
The account or company name is not displayed in File > Help > About in 
Workshare Compare.

01018577
Worldox document footer stamps are not updated when saving a 
comparison via Save As in Workshare Compare.

01018743
The font in the email body changes to Times New Roman when sending 
attachments to groups in Interactive Protect.

01028440
Editing a rendering set on the fly does not prompt to save as a new set or 
overwrite the current rendering set.

40418
When comparing particular presentations, 'Index was outside the bounds of 
the array' error is displayed.

40430
When comparing presentations and at least one has the Opulent design 
theme applied, a ‘Color is not resolved yet’ error is displayed.

http://www-10.lotus.com/ldd/fixlist.nsf/8ed1b46cfdba8957852570c90054623b/dbf1eb80caf496f0852580d800738d12?OpenDocument
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Ref Description

40469
In Compare for PowerPoint, a newly created comparison theme does not 
appear in the Select dropdown in the Home ribbon (Comparison Themes 
group).

40574
A user is not automatically logged into Professional after logging into the 
desktop app first (64-bit version only).

40597
The local file store dialog is displayed when browsing for files from the 
desktop app when a DMS is set as the default (64-bit version only).

41284
In Compare for PowerPoint, comparisons of DMS files are not listed in the 
recent comparison list (File > Open > Recent).

41547
When a PowerPoint presentation is run from the command line, the incorrect 
comparison theme is highlighted under the Select dropdown in the Home 
ribbon.

45583
When a machine is restarted before the convert to link process has 
completed, files which are not synced are moved to a conflict state in the 
desktop app.

Contact Info

For technical help and support on Workshare products, contact Workshare Customer 
Support:

support@workshare.com
EMEA: +44 207 539 1400
US: +1 415 590 7705

For sales enquiries, contact the Workshare Sales team:

sales@workshare.com
EMEA: +44 207 426 0000
US: +1 415 590 7700
APAC: +61 2 8220 8090
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Workshare Ltd.
© 2019. Workshare Ltd. All rights reserved.

Copyright
Workshare Professional and Workshare DeltaView are registered trademarks of Workshare Ltd. Workshare Compare, 
Workshare Protect, Workshare 3, Workshare DeltaServer, SafetyGain, and the Workshare logo are trademarks of 
Workshare Ltd. All other trademarks are those of their respective holders.

Trademarked names may appear throughout this guide. Instead of listing these here or inserting numerous trademark 
symbols, Workshare wishes to state categorically that no infringement of intellectual or other copyright is intended and 
that trademarks are used only for editorial purposes.

Disclaimer
The authors/publishers of this guide and any associated help material have used their best efforts to ensure accuracy 
and effectiveness. Due to the continuing nature of software development, it may be necessary to distribute updated help 
from time to time. The authors would like to assure users of their continued best efforts in supplying the most effective 
help material possible.

The authors/publishers, however, make no warranty of any kind, expressed or implied, with regard to Workshare 
programs or help material associated with them, including this guide. The authors/publishers shall not be liable in the 
event of incidental or consequential damages in connection with, or arising out of, the programs or associated help 
instructions.

For details of Workshare patents, see www.workshare.com/patents

Revisions
Published for Workshare Professional 10.0: 18/12/18; minor revisions: 17/1/19 & 15/2/19
Revised for Workshare Professional 10.1: 27/3/19
Revised for Workshare Professional 10.1 Revision 1: 16/5/19
Revised for Workshare Professional 10.2: 28/6/19

Workshare Ltd., 20 Fashion Street, London E1 6PX www.workshare.com

http://www.workshare.com/patents
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